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ELEASE READ BEFORE USING

Discrete Signals and Systems II
TRANSFORMS, WINDOWS, MODULATION... 1.0B

* Note that the Transforms, Windows, Modulation... software is version 1.0B
[beta]; the accompanying manual is for version 1.0. Therefore some options are
not fully functional as described in the manual.

*

5.3 since the screen will not refresh if File menu is used.

* The TWM data folder must be on the same disk as Transforms, Windows,
Modulation..,., Otherwise, "File Error" will occur as you start the program and the
program may crash if you proceed. This folder contains the "TWM Image Folder"
and the "TWM Scrap Folder" ; The images necessary for the operation of the
program are stored in the TWM Image Folder.

* Make sure that the Discrete Signals and Systems disk is unlocked: otherwise
"File Error" will occur when you attempt to store a signal in a Storage bin.

[1] Note that due to a limitation of graphics routines and screen resolution, discrete
data values may appear ynevenly spaced when the display width exceeds 60 points;
also, when an array is all negative, tickmarks may overiap. In the "Point by Point"
mode, if the value entered falls beyond the specified boundaries, lines may be drawn
over the scroll bar.

[2] All desk accessories are operational; however, if a desk accessory is moved
around on the screen, the screen will not refresh until the accessory is put away.

[3] If infinite (INF) numbers are created during an operation, clear the signal in the
graph window and proceed. If vertical lines appear on the screen, please save all
signals and exit the program and restart. INF values may occur when using the
exponential function generator or the exponential operation, if the base and/or the
exponent are not carefully selected.

[4] The dialog boxes in this version can not be OKed by pressing the Return or Enter
key and may close on alpha keyboard characters. Upon cancelling, new entries to a
dialog box may be set instead of being ignored. Also, the dialog boxes are not fully
protected against illegal entries. Some dialog boxes accept scientific notation (e.g.
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1e-2 for 0.01). However, if e is not preceded by a numeric character, the

program may crash. We suggest that you enter values according to the fype of the
default/set value in the dialog box. Whenever applicable, enter boundary values in the
right order (larger number for the upper bound; smaller number for the lower bound etc.)

[5] Do not use Open signal, request Last Signal or return a signal to the Graph
window when set in Instantaneous Frequency or Power in either domains. If you
do, select Real part to activate normally available functions and operations. Also, if
Real part is selected, yet normally available functions are not activated, select Real
Part to activate them. ‘ '

[6] To obtain the correct value of the Instantanecus frequency, multiply the signal (or
Y-axis scale ) by the Transform record length (i.e.128, 64, etc.)

[7] The Window graph option provides a number of commonly used data windows.

In this version, windows with center symmetry- (Bartlett, Generalized Hamming,
Blackman) may not be centered properly. For an odd length window (e.g. from -30 to 30
[61 points] or 0 to 30 [31 points], subtract 1 from the window length, and enter window
limits based on this value. If the windowed signal is not centered, use x-axis shift to
position it properly. If the tails of the windowed signal are not symmetric, use Edit
Graph to correct for discrepancies (especially for Von Hann and Blackman.) Also,.in
this version, the Gaussian window assumes zero mean and is centered at the origin.

[8] If more than one Storage bin are selected, the Store graph option will store the
signal in the Graph window in all the bins; however, only the first bin will show the
signal. Also, note that when Oper.l menu items operate on selected bins. Therefore,
deselect bins if the operation is to occur on the signal contained in the Graph window.

[9] In this version, the Semilog and Decibel (dB) menu items under the Display
menu are not available.

USAGE SUGGESTIONS

"Signal Operations 1.2" and "Transforms, Windows, Modulations... 1.0" are the first and
second modules of the Discrete Signals and Systems package. The two
programs can exchange data and complement each other in many functionalities. A

particularly convenient approach is to install both apptibations on the Switcher ™M,



Ll

Se——

Contents

TRANSFORMS, WINDOWS, MODULATION...
ON THE MAC

"HOW TO USE THIS DOCUMENT

USING TRANSFORMS, WINDOWS, MODULATION...
How to Begin
Generating a Signal
Storing a Signal on the Screen
Creating a Signal Point by Point
Editing a Signal
Performing a Signal Operation on One Signal
Performing a Signal Operation on Two Signals
Retrieving the Last Signal and Signals Stored in Bins
Comparing Two Signals
Performing a Transformation on a Signal
Viewing Different Parts of the Signal
Making a New Signal
Windowing a Signal
Obtaining a Hardcopy of a Signal
Saving and Opening Signals
Leaving Transforms, Windows, Modulation...

SOLVING PROBLEMS WITH
TRANSFORMS, WINDOWS, MODULATION...

REFERENCE
Menu Summary
Short Cuts
Signal Generator Summary
Special Considerations
Should You Have Problems. . .

W o0 1 uhhwww

el el el s T =y e

14

17
17

24



TRANSFORMS,
WINDOWS,
MODULATION...
ON THE MAC

page 1

The Transforms, Windows, Modulation... program for the
Macintosh is part II of the Discrete Signals and Systems
package. This package consists of a set of software prepared
for engineering courses in discrete signals and systems.
Transforms, Windows, Modulation... aims to provide an
interactive environment whereby the student can experiment
with a multitude of theoretical and applied concepts while
routine computations and display tasks are performed by the
computer.

With the Transforms, Windows, Modulation... module,
discrete complex signals can be created on a working window
called the Graph Window. These signals can be stored in any
of five Storage bins at the bottom of the screen. Time signals
can be transformed into the frequency domain and vice versa
using the discrete Fourier transform implemented by the Fast
Fourier Transform (FFT) algorithm. It may be advantageous to
familiarize yourself with the FFT algorithm which was
developed by J. W. Cooley and J. W. Tukey (see Math. Comput.,
vol 19. April 1965, pp. 297-301). Many textbooks on discrete
signals and systems discuss the algorithm. For a detailed
presentation, you may refer to the book by E. O. Brigham
entitled "The Fast Fourier Transform” (Prentice-Hall,
Englewood Cliffs, NJ, 1974) or the one by R. W. Ramirez
entitled "The FFT Fundamentals and Concepts” (Prentice-Hall,
Englewood Cliffs, NI, 1985).

Transforms, Windows, Modulation... is similar in screen
layout and mode of operation to Signal Operations, which is
part I of Discrete Signals and Systems package. The major
difference between the.two programs is the type of data.
Transforms, Windows, Modulation... works on complex data
while Signal Operations is limited to real data. However, the
two programs can read data files created by each other; the
Signal Operations program opens the real part of a complex
signal saved by Transforms, Windows, Modulation... and
Transforms, Windows, Modulation... opens a signal saved by
Signal Operations as a real signal. (The imaginary part is set
1o zero.)

In this version of Transforms, Windows, Modulation..., a
sampling frequency option is not included. We have decided
to withhold this option from this educational version in order
to present the actual results of the FFT algorithm independent
of the sampling rate. If necessary, a sampling frequency can
be used to scale the time and frequency axes as discussed in
"Special Considerations" in the "Reference” section.

This module offers a number of signal operations,
Discrete Fourier transformation, windowing and angle
modulation options, which can be performed on both time and
frequency signals. Some of the operations require only one
signal whereas some operate on more than one.
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One signal More than one signal

x-axis shifting addition

x-axis scaling subtraction
y-axis scaling (amplitude scaling) multiplication
changing sign (rotating about x-axis) division

folding (rotating about y-axis)

absolute value

sum Signal Windows
summation Rectangular
difference Bartlett (triangle)
even part Generalized Hamming
odd part Blackman
logarithm : Gaussian
exponentiation

angle modulation

Fast Fourier Transform (FFT)

windowing

This documentation describes how to use the Transforms,
Windows, Modulation... module as an interactive learning tool.
Since this module is similar to the Signal Operations module,
the documentation is also very similar. If you are already
familiar with the Signal Operations module, you might want to
concentrate on sections particular to the Transforms,

Windows, Modulation... module. Various program features are
described in "Using Transforms, Windows, Modulation...”
section of this manual. "Solving Problems with Transforms,
Windows, Modulation..." shows how you can use the module to
solve problems in your textbook or those you make up

yourself. An overview of the various features of Transforms,
Windows, Modulation... (TWM) is provided by the "Menu and
Siganl Generator Summary” in the "Reference” section.

If you are not familiar with the Macintosh™ computer, it
might be advantageous to review Macintosh , the owner's
manual. It teaches the basic techniques you will use to create
signals — clicking, selecting, choosing menu commands,
obtaining hardcopy of the screen contents, saving the
contents of the screen as a MacPaint™ document, etc.



USING
TRANSFORMS,
WINDOWS,
MODULATION...

How to begin:

To generate a
signal:

page 3

B Insert the Discrete Signals and Systems II disk.

B Open the Discrete Signals and Systems II disk icon.
Check that the Transforms, Windows, Modulation...
data folder is on the disk. This folder contains
images necessary for the operation of the program.

B Open the Transforms, Windows, Modulation...

module icon.
The DOMAIN SELECT bas informs The Oraph windew is where you
you of the current domain and plot and edit signals.
you change demams by :

chioicing on the deswed optien. The menu bar centains the titles of menus
: from wivich y oy ohoese commancds.

3 6 File Oper.| Oper.I! Display Options Transforms Shumé
‘ T e Groph window & _ Y(0l= 0.00 e+0 &[]

f....The CLEAR bax lets you olear the Oraph windew.

Bax where the numerical value of the
the signal cerr to the posttl

q: se2ss The sorol bar lets you meve the signal
: * The pt. by pt. baxt alk you to in the Groph Yindew sidewoys to see
- --- - qenerate a signal peint by point i dHi¥orent parts of it.

mehw-nwmmhndﬂmm('mﬂw-»dhﬂmm.

M Click the signal generator box named "impulse".
The impulse signal will appear in the Graph window:

2 Graph window = Y¥(0]= 1.000e+0 §
¢1.000e+0
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Signals can be generated either in time or frequency
domain.
M Click FREQ in the DOMAIN SELECT box. It will
become hlghlighmd_ DOMAIN SELECT

TIME
The impulse generated earlier has become a frequency
function. The domain of signals can be switched at

any point in the program.

Note that only one part of a signal can be generated at
a time. The other part is automatically set to zero,
except when a signal is generated in phase. In this
case the magnitude is set to 1. If the magnitude of a
signal is generated, the absolute value of the
waveform is taken since the negative magnitude is
meaningless. If the signal is complex, it can be
generated in separate parts, then combined to obtain
the complete signal. The real and imaginary parts can
be added; magnitude and phase can be multiplied.

M Select the-part of the signal to be generated (real,
imaginary, magnitude or phase) from the Show
menu. See "To view different parts of a signal”
below. Generate a new signal, say a pulse. See "To
Make a new signal" below for a more convenient

procedure to assign parts of a signal.

The total number of points in any signal is 129
[extending from -64 to +64 x-axis units]. You can read
the individual values of the signal array by moving

the pointer on the graph. Different portions of the
signal can be viewed by moving the scroll bar. To
view more than 23 points, choose Set display
width from the Display menu.



To Store a signal M  Click Storage bin #1.

on the screen: B Choose Store Graph from the Options menu.
A small plot of the signal in the Graph window will
appear in Storage bin #1 to help you recall its
contents. Letters appear on the left side of the storage
bin to indicate the domain of the signal (T for time

- domain, F for the frequency domain) and the type of
coordinates used, (R for real, I for imaginary) in
rectangular coordinates, (M for magnitude, @ for
phase) in polar coordinates.

w A

1-— gt

Unlike the Signal Operations module, TWM signals
stored in bins are also saved as disk files. The storage
of one complex signal requires at least 3K of disk

space.
To create a signal W Click the signal generator box named "Pt. by Pt."
point by point: A dialog box like this will appear on the screen:

II Enter upper vertical ' "
bound of data :

Enter lower vertical

bound of data :

B Type the numbers 2 and -2 for the upper and
lower bounds of data respectively. Note that the
Tab key selects the second entry in the
dialog box. Click OK or press the Return key.
A blank Graph window is now ready for you to enter
points. You can do this in either one of two ways: by
pointing to the location and clicking, or through the
tiny dialog box in the upper right corner of the Graph
window. .

To enter the point Y(0)=1.25:
B Position the pointer on the y-axis and drag until
¥ = 1.2500 is displayed in the dialog box.
Release the mouse button. Note that the point you
page 5 just entered is displayed in the dialog box. If




y= 1.25, try again by repositioning the pointer,
dragging, and releasing. Your first entry will be
replaced by your second entry.
If you are not satisfied with the resolution of the
mouse, you can enter the exact values through the

dialog box.

To enter the point Y(2)=0.500:

M Move the pointer along the x-axisuntil 0 = 2 is
displayed in the dialog box. Note that the values of
n and Y are continuously updated.

M Press the Tab key. The ¥-value box will became
highlighted.

M Type the number 0.5. [Note that this dialog
box also accepts scientific notation, e.g. Se-1 is
equivalent to entering 0.5].]

B Press the Enter or Return key to enter this point
into the signal array. Pressing the Tab key once
causes either the n- or ¥- value box to be
highlighted. Pressing it again causes the other
value box to be l:nghhghted.

) () -
B Now enter the point Y(4)=-0.5 into the signal array.

The Graph window should now look like this:

Graph window || N'EIV‘

000

=0 7 8 % <] LT3 3 Z 9

1

M Click the box in the lower left comer of the screen
when you have finished entering points. -

CLICK HERE
WHEN R
FINISHED

page 6



To Edit a signal:

To perform an
operation on one
signal:

To perform an
operation on two
signals:

page 7

Editing is performed the same way as point by point
entry. The only difference is that you make changes

on an existing signal rather than starting from a blank
window. You can edit signals by choosing Edit graph
from the Options menu.

B Choose H—-axis shift from the Oper. | menu. All
signal operations requiring only one signal are
grouped under the Oper. | menu. Type the
number 2 for the value of K in the dialog box, then
click the radio button for linear shift.

f(n) --> f(n-K) ...
k = [EA_]

@ Linear Q Cyclic

@) T

. The signal in the Graph window will be shifted to the

right by two x-axis units.

B To review, generate an impulse as a real time
signal. Shift it to the right by two time units and
store this signal in bin #2. :

M . Click the signal generator box named "sine" while
set in the time domain and in real part.

A dialog box with default values will appear. Click OK.

A sine with these default values should appear on the

graph window.

2
B Select Storage bin #2 by clicking it. ﬁ-l
B  Choose Add from the Oper. 11 menu. All

operations requiring more than one signal are
grouped under this menu.



To retrieve the
Last Signal:
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The result of the addition will appear in the Graph

window:
EIi========= Graph window == V(2] 2.383e+0 §|
2383e¢0
%

M Store this signal in any empty Storage bin (say, #5).

To perform a two-signal operation on two or more
stored signals, click on two or more Storage bins and
then choose one of the signal operations from the
Oper. |1l menu. When only one Storage bin is
selected, the signal in the Graph window becomes the
second signa) by default.
Ifanopmanonbctwwnhvos:gna]sdeﬁnedmtwo
different domains is requested, a "mixed mode"
warning is issued and results are set to the current
domain of the program.

Whenever a new entry is made into the Graph

window, the previous contents of the window are

temporarily stored until another new entry to the

Graph window is made. To retrieve the original sine

waveform:

B Choose Last Signal from the Show menu.
Transforms, Windows, Modulation... will return the
sine to the Graph window, and a small window will
appear at the bottom left comer of the screen:

ElIm
.lF.llH-

This is the Last Signal window. Transforms, Windows,
Modulation... automatically stores the previous
contents of the Graph window here. It now contains
the result of the addition.



To retrieve a
signal stored in a
bin:

To Compare two
signals:
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m Choose Last Signal again to exchange the contents
of the Graph window with the contents of the Last
Signal window.

You can return any stored signal to the Graph window
at any time by clicking on the number in the upper

left corner of its Storage bin or by opening the bin
using Open signal menu item under the File menu.
The domain of the program is switched to the domain
of the retrieved signal.

Transform, Windows, Modulation... also lets you
display two signals in the Graph window
simultaneously.

B Click the signal generator box named "impulse"
again to generate an impulse, or click on the
number 1 in the upper left corner of bin #1 to
return the impulse to the Graph window.

M Select Storage bin #2 which contains the shifted
impulse.

B Choose Compare graph from the Options menu. A
dialog box will ask which part of the signal in the
bin you want to compare with the signal in the
Graph window. Choose the real part by clicking the
corresponding radio button.

The Graph window will look like this:
B e— Graph window == Y(0l= 1.000e+0 &

T.000e+0

The shifted signal has been superimposed in lighter
color on the original impulse.



To perform a
transformation

on a signal:

To view different

parts of a signal:
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Transforms, Windows, and Modulation... allows you to
take the Fast Fourier Transform (FFT) of the signal in
the Graph window. Depending on the domain of the
signal, this will be either a forward FFT (FFT) or an
inverse FFT (IFFT). The FFT algorithm can be set to
operate on 4, 8, 16, 32, 64, and 128 points. If the
transform record is less than 128 points, the
remainder of the signal is filled with zeros. This
causes defactg zero-padding of the transform results.

In this implementation two kinds of phase
reference can be chosen. One is with respect to the
zero-point on the graph window (fixed zero) and the
other is with respect to the first point of the record
specified by the user (free zero). The Set transform
record menu item will define the interval over which
the FFT is to be performed and the phase reference.

B Click the sine to generate a sinusoid. Click OK in
the dialog box, which will generate the default sine
wave of period 32. Now choose Set transform
record from the Transforms menu. Check to see
that the default value for the number of points is 128
and the phase reference is set to the zero-point on the
graph (fixed zero), or set to Free Zero with record
starting at zero. Now choose FFT. Upon completion,
the graph window will display the magnitude of the
spectrum of the sine wave. Note that Set transform
record preserves the last setting until a change in
record is entered, so it is not necessary to reset it
before each transform is performed.

The Transforms, Windows, Modulation... module can
display complex time and frequency signals in
different modes: real and imaginary, magnitude and
phase using the menu items under the Show menu.

B To display the real part of the spectrum of the sine
wave on the Graph window, choose Real part
from the Show menu. The real part of the
spectrum should be all zeros as expected.

B Now choose Imaginary part.



To make a new
signal:
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The graph window should look like this:

B e Imaginary part vi8l = 0.000e+0 H

5.000e+0

o

Repeat for Magnitude and Phase. Note that the phase
units can be set to degrees or radians using options
under the Display menu.

Power and Instantaneous Frequency/ Group
Delay are computed from the current signal array for
observation and comparison purposes only. In order

not to alter the current signal, no operations, editing or
windowing are allowed on these plots.

a9

M Generate a real sine wave. Display its phase by
choosing Phase from the Show menu. [By
convention, negative real values are assigned a
phase of -x radians at positive frequencies and ©
radians at negative frequencies.]

B Choose Make Signal from the Options menu.
This will allow a new signal to be created from part
of an existing signal (real or imaginary, magnitude
or phase parts). A dialog box will appear to help
you set the part of the destination (i.e. the new
signal). Note that the radio button for phase has
been selected as the default. Click the radio button
for real as shown in the figure below:

Set destination of signal:
Qrenl Q imaginary O magnitude O phase

Signal shown : phase




The phase of the sine wave has become the real part
of the new signal and its imaginary part is set to zero.

To Window a B Choose Window graph from the Options menu.
signal: The signal in the Graph window can be multiplied
by a number of window functions. Select the

Bartlett window by clicking its radio button and
entering -32 and 32 as the start and end points of
the record.
The window function will appear in grey
superimposed on your signal. The window can be
moved to the right by the space bar and to the left by
the backspace key. Try moving it around by using
these keys.

B After you have positioned the window properly,

click the rectangle on the lower left corner that says
"CLICK HERE WHEN FINISHED". The program will
multiply your signal with the window and display the
result.

To recover the original signal, select Last signal
from the Show menu.

The Gaussian window accepts the mid-point between
start and end points as its mean value and half of the
window length as its standard deviation.

To print a signal: | B To print the entire screen: With Caps Lock down,
hold down both the Command and Shift keys while
you type the number 4.

B To print the contents of the Graph window: Hold
down both the Command and Shift keys while you
type the number 4.

B To create a MacPaint™ document with the contents
of the screen: Hold down both Command and Shift

keys while you type the number 3.
To Save and Open The signal displayed on the Graph window can be
signals on the saved as a document on the disk by selecting Save
disk: signal under the File menu. Saved signals can be

retrieved by choosing Open signal. Note that
Transforms, Windows, Modulation... can be opened

page 12



Leaving.
Transforms,
Windows,
Modulation...
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from the desktop by double clicking on the document.
The Signal Operations and the TWM modules can open
signal documents saved by each other; the Signal
Operations opens the real part of a complex signal
saved by the TWM program; the TWM program opens
a signal saved by Signal Operations as a real signal

(the imaginary part is set to zero).

B Choose Quit from the File menu. Upon quitting
the program, if you have any signals stored in the
bins, they will be saved as scrap files in the scrap
folder. You may delete all but the scrap #0 file in
this folder, if you delete all scrap files the program
will create an unnamed folder to place these scrap
files next time you quit. Upon quitting, the scrap
files already on the disk will be deleted before
writing the new scrap files.

If you are forced to exit the program due to a system
error, the signals stored in the bins will still be kept in
the scrap folder under the bin # name and can be
retrieved by the Open Signal command next time

the program is started.
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Figure 1

Since the Transforms, Windows,
Modulation... module is similar to the

Signal Operations module in its screen

layout and philosophy of operation, users
who are familiar with the first module

should not need further instruction to

operate this program. The major

differences are the addition of two more
pull-down menus to accomodate the Fast
Fourier Transform and to view different

parts of signals. Additional items under

the Option menu are Window graph and
Make signal. Window graphisa
collection of popular data windows and
Make signal serves to create a new signal
out of an existing signal. Additional items
have also been added to the Display menu.

The problems below are similar to the ones
solved in an introductory level signals and
systems course. The intent is to illustrate
the applications of this program and to
help visualize theoretical concepts, verify
comprehension of the subject material.
You need not follow the given steps since
each user will develop a different
approach to the problems.

Q1) This problem is to study the
symmetry properties of the Fourier
Transform of a real discrete signal.
Using a square puise, demonstrate that:
Even {y[n]} = ye[n] < F > Real {Y[N]}
Odd ({y(n]} = yg[n] < F > Imag. {Y[N]}
where F stands for discrete Fourier
transform and N for discrete
frequencies.

Al) Generate a square pulse of width 8
and starting from zero in the time domain
and in real part. (These are the defauit
values for the square pulse generator.)
This is y(n]. Store y([n] in bin #1. To take
the Fourier Transform of y[n], select FFT
from the Transforms menu. Note that the
transform is taken over 128 points, which
is the default of the transform record. The
magnitude spectrum is shown in the
Graph window. To see the real (i.e. Real
{Y[N1}) and the imaginary (i.e. Imaginary
{YIN]}) parts of the spectrum, select Real
and Imaginary menu items from the Show
menu. Store the spectrum in bin #2. (See
Figure 1)
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Clear bin
£dit graph [ a
Window qraph...

Recall y[n] from bin #1 by clicking on
the bin number. Take the even part of
y[n] by choosing Even part from the
Oper. | menu. This is y.[n]. Take the
transform of y. [n]. Observe the real and
imaginary parts of Y, [N]. As expected, the
real part of Y, [N] is identical (within
truncation limits) to the real part of Y[N]
and the imaginary part is zero. Compare
Real{Y[N1} and Real{Y, [N]} as in Figure 2.

Repeat the same steps for the odd part
of y[n]. You will see that Y, [N] has zero
real part and its imaginary part is
identical to the imaginary part of Y[N] as
compared in Figure 3.

Q2) This problem illustrates the
concept of amplitude modulation (AM).
Simulate in discrete time the amplitude
modulation (AM) process

sin wgt (1+ um(t]) , where sin wet is

the sinusoidal carrier and m(t] stands
for the baseband message to be
transmitted and p is the moduiation
index which is set to 1 in this example.

Al) Suppose the message consists of two
sinusoids added together, one with a period
of 128 points and the other with half the
period, 64 points, i.e.

m(n] = sin (21/128)n + 0.5 sin (2/64)n.
Generate a sine by clicking on the "sine"
box, enter 128 for the period. Store this
sine in bin #1. Generate another sine of
amplitude 0.5 with period 64 in the same
way. Add the two together by
highlighting bin #1 and choosing Add
from Oper. Il menu. Store the result in
bin #1 again.

D.C. can be generated from the square
wave with the following parameters in the
irrelevant, amplitude: 0, delay:
irrelevant, DC offset: 1. Add this to the
contents of bin #1 and store the result in
bin #1 again. Your baseband signal is
now in bin #1.

Generate a sinusoid with amplitude of
1.00 and a period of 16 points to serve as a
carrier. Store the carrier in bin #2.
Multiply the carrier with the baseband
signal. (See Figure 4) This is the
modulated carrier. Store the result in bin
#3.



" & fiie Oper. | Oper. !l Oisplay Options Transforms Show

AR Graph window B
FREQ 2.29
i
square
et - i
oo
cpeasatial
notee
pL by pt. 3 i LR E LR l SR TR s R
[REELRES
-
Figure 5

" & Fue Oper.1 Oper. Il Displey Options Tramsforms Show

A SELECT Magnitude &
Ll 13 FRED y 5.000e-1
meuisy
o
sawissth
e
earstil
s
. by pt. L i G e R R AR s e R R
H
Figure 6

r

@& File Oper.| Oper. !l Displey Options Transforms Show

SELECT Megnitude Sl
TIME | p
[—
sqare
saviesth ol k
]
s !
newo i l
o by ot T -r... 7 ] !gi;i i BRI
H
]
Figure 7

page 16

For best visual effects, set display
width to 129, change pen size to 2 and
choose Connect points, all from the
Display menu. Compare your modulated
signal with your baseband signal by
highlighting bin #1 and choosing
Compare graph from the Options menu.
Note that the baseband constitutes the
envelope of the modulated signal. (See
Figure 5)

Change the display mode back to
Discrete and the pen size to 1. Obtain the
spectrum of your baseband by recalling it
from bin #1 and taking its Fourier
Transform. Look at different parts of the
spectrum and identify the DC and the two
harmonics and store it in bin #4. Then
obtain the spectrum of the modulated
carrier stared in bin #3. (See Figure 6)
Note that the baseband spectrum has been
shifted in frequency by the carrier
frequency. (See comparison in Figure 7)
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Save signal 38S
Open signal 30
Quit %0

Saves the signal in the Graph window to the disk.

Opens a stored signal into the Graph window. The real
part is displayed.

Exits the program and returns to the desktop. The
signal in the Graph window and the signals in the
storage bins are saved as scrap files in the scrap

folder.

Oper. |

H-anis shift
H-anis scale
Y-anis scale

Change sign  -Y(nl
Fold ¥(-nl
Absoluta veiue |¥(n]l

Sum
Summation
Differencs

Even part
Odd part

Lag |¥Inll
Exponential

Aingle moduiation

Moves the signal on the x-axis (time axis) K integer
units, i.e. changes the signal from f(n) to f(n-k).
Displays a dialog box to specify the type of shift, linear
or circular, i.e. wrap-around, and the integer value of
K.

Expands or compresses the x-axis, i.e. changes the
signal from f(n) to f(An/B). Displays a dialog box to
enter positive integer values of A and B. Expanding

the horizontal scale will place zeros between points.
(See "Special Considerations” in the "Reference" section
of this manual.)



Y-anis scaler =

Change sign: -¥In]

Absolute value: |¥[nl|

Difference

Even part .
0dd part

Log 1¥(n]I

Exponential

Angle modulation
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Increases or decreases the amplitude of the signal, i.e.
changes the signal from f(n) to (A/B)f(n) according to
the scale factors A and B entered through a dialog box.

Rotates the signal around the x-axis, i.e. changes the
signal from f(n) to -f(n).

Rotates the signal around the y-axis, i.e. changes the
signal from f(n) to f(-n).

Takes the absolute value of the signal array, i.e.
changes the signal from f(n) to |f(n)|.

Performs the sum of values from one specified point to
another, i.e. computes Y(n) = X f (k), where k goes from
i to j, and displays Y(n) as an impulse at the point j.
Values of i and j are entered trough a dialog box.

Performs a running sum of a signal array, L.e.itis a
first order (rectangular) numerical integrator.

Finds the difference of the points in a signal array, i.e.
it is a first order numerical differentiator.

Takes the even or odd parts of a signal array.

Takes the logarithm of a signal. Base values

(e,10, etc.) are entered through a dialog box. Zero
signal values can be set to user defined values using
Set display zero.

Takes the exponential according to the specifications in
the dialog box. You can toggle between f(n)B or Bf(")
modes, and specify the base or the exponent as 10, e,
or as another number. If the exponent is not an

integer and the base is negative, the absolute value of
the base is taken to avoid generating complex

numbers.

Angle modulates (phase or frequency) a sine wave
carrier with the signal in the graph window.: The part
of the signal which modulates the sine wave is
indicated through a dialog box. The carrier sine wave
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B

and other modulation parameters are entered in the
same dialog box.

Performs the addition, subtraction, multiplication, and
division respectively of two or more signal arrays. In
the case of division by zero, a warning is issued and
the results are set to zero. If only one bin is selected,
the signal in the Graph window becomes the second
signal by default.

Display
Change pen

Set display width
Center graph
Set display zero

Discrete
Connact points

Linear
Semi-log
dB

Changes the thickness of the graph lines.

]

| Changes the number of points shown in the Graph

window. [The number of points in a given signal is 129
(extending from -64 to +64 on the x-axis).]

Re-centers the signal in the Graph window after it has
been moved with the scroll bar.

For graphing purposes, values less than a user defined
minimum are considered zero. The default is set to
106 (or in scientific notation 1e-6).

Plots the signal at discrete points. (This is the system
default since all digital computer operations are
inherently discrete.)

Connects the discrete points by drawing a straight line
between two adjacent points. This is only a visual
effect. The signal remains discrete.

Selects the units in which the phase information is
displayed.
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Plots the magnitude and power of a signal linearly,
semi-log, or in decibels. For other signal parts (i.e.
real, imaginary and phase) only linear option is .

available.

Options
Clear hin

Edit graph
Window graph
Compare graph
Store graph
Make signal

Clears the contents of the selected storage bin.

Modifies the signal in the Graph window by clicking on
a given point or by entering numerical values through

a dialog box. Displays a small dialog box in the upper
right hand comer of the Graph window that displays

the element number and the x and y values
corresponding to the location of the pointer (see text
for details).

Windows the signal in the Graph window. A choice of
commonly used 'signal windows' are available through
a dialog box.. The user specifies the window type and
enters the width of the window. The specified window
appears in grey, superimposed on the displayed signal.
The window can be moved through the keyboard.
Pressing the space bar or backspace displaces the
window to the right or left by one unit, respectively.
Upon clicking on the box "CLICK HERE WHEN
FINISHED", the signal is multipled with the window
function. The Gaussian window accepts half of the
window length as its standard deviation. Note that
other windows can be designed using 'signal generator
boxes' and the appropriate combination of signal
operations. Once designed, they can be applied onto
the signal using the 'multiplication’ option.

Superimposes, in lighter intensity, the selected signal
(from a storage bin) on the signal in the Graph
window.

Stores the contents of the Graph window in the
selected storage bin(s).



Make signal Makes a new signal out of the signal contained in the
Graph window. The contents of the window are

assigned to either real or imaginary part or magnitude

or phase of a new signal by responding to a dialog box.
The domain (i.e. time or frequency) can be selected by
clicking on the DOMAIN SELECT box. Note that making
'phase’ from another signal will automatically fill the
magnitude of the resulting signal with ones since

phase cannot exist without a nonzero magnitude. In

other cases (i.e. real, imaginary and magnitude), the

second part of the signal will be set to zero.

e

Set transform record

Takes the Discrete Fourier Transform of the signal in
the Graph window using the Fast Fourier Transform

(FFT) algorithm. In the frequency domain this menu
item changes to IFFT, to take the inverse transform
using the same algorithm with appropriate scaling.

Defines the record, i.e. the signal interval over which
the FFT will be performed. The starting point and the
number of points in the record are entered in a dialog
box. The user can set the starting point of the record
anywhere on the x-axis using Free zero option. This
mode is consistent with the conventional FFT
algorithms that operate on data taken from an event
and the start of the record is selected as the zero point.
Fixed zero refers to the zero point as seen on the

graph.
Show
+Real

Imaginary

Magnitude
Phase

Power
Instantaneous Freq

Last Signal
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These options are self explanatory. Note that when
the imaginary part of a signal is zero, the convention
for assigning phase is: negative real values for
negative time or frequency are assigned +180°; those
for positive time or frequency are assigned -180°.

These options are for viewing purposes only; menus
and menu items that would alter the original signal
are disabled. Power displays the square of the
magnitude of the signal on the graph window.
Instantaneous Freq (or Group Delay)
approximates dg/dt or dg/dw by the difference of
the phase array, depending on the domain of the
waveform displayed, multiplied by the appropriate
factors. (See "Special Considerations”.)

Replaces the signal in the Graph window with the
signal in the Last Signal window. (The Last Signal
window contains the contents of the Graph window
prior to the most recent entry.)

B Press the Option key and a number to select a
Storage bin directly from the keyboard.

M Press the Enter key and a number to store a signal
in a Storage bin directly from the keyboard.

B Press the Return key and a number to return the
contents of a Storage bin to the Graph window
directly from the keyboard.

Note: When using these shortcuts, the number

0 must be used for the 10 bin.

M The following keys are functional in Window
graph mode:

moves window to the right along the x-axis.
moves window to the left along the x-axis.

= "CLICK HERE WHEN FINISHED"



Signal Generator
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Generates the unit sample function.

Generates a square pulse train according to
specifications entered through a dialog box.

Generates a triangular pulse train according
to specifications entered through a dialog box.

Generates a sinusoidal function. The harmonic number
and the peroid must be positive integer values. The
amplitude is entered in decimal or scientific notation
(i.e. 0.002 can be entered as 2e-3). The phase is
entered in degrees or radians (as multiples of ©
[3.14159...] or directly in radians) and automatically
converted to the other unit.

Generates the exponential sequence BAn, The base is
specified as 10, e, or by typing any number. If the
exponent is not an integer and the base is negative,
the absolute value of the base is taken to avoid
generating complex numbers.

Generates pseudorandom noise function.

Arbitrary functions can be generated point by point
using this option. See "To create a signal point by
point” in the "Using Transforms, Windows, Modulation"
section of this manual.



SPECIAL
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X-Axis Shift
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As in any other software application, the "Transforms,
Windows, Modulation" program has features which at times
may appear as program 'limitations’. These limitations are due
in major part to peculiarities of the hardware and software
used as well as the overall design and philosophy of the
program. In order to facilitate the program operation and
enhance important features, we have adopted an approach
which has resulted in the following limitations.

In order to limit the size of the program, signal arrays are
limited to a total of 129 points extending from -64 to +64. Due
to this limitation, signals that actally extend beyond the
limits of the array will be represented as pulses from -64 0
+64. For example, if a sine is generated, the outcome is a
sinusoid pulse that extends from -64 units of time to +64 units
of time. Similarly, if a unit step is generated, the outcome is a
rectangular puise that goes from 0 to +64. This limitation has
important implications in the following operation:

H-Axis shirt

If the actual signal extends beyond +64 or -64 and linear x-axis
shifting is specified, this operation may bring in zeros rather
than filling in with appropriate values. For example, a unit
step shifted to the left by 10 units will result in a rectangular
pulse from -10 to +54. Linear x-axis shift in the direction of
the extension is not reversible. As an example, try shifting a
unit step to the right by 10 units and then shift the result to
the left by 10 units. However, if cyclic shift is chosen, the
latter shortcoming is eliminated.

FFT/Set transform record

If the FFT algorithm is used with a transform record length
less than 128 points, the remainder of the signal is filled with
zeros. This defacto zero-padding is necessary because the
program is set to operate only on the fixed array size of 129
points.

The x-axis scale and x-axis shift dialog boxes accept only
integer values. Rounding to the next integer will occur for
decimal entries greater than or equal to a half. Furthermore,
x-axis scale will take the absolute value of the scale factors.
Rounding to the next integer value might resuit in some
inconsistencies. For example, a sequence, f[2n-3] can be
represented as f[2(n-3/2)]. However, time scaling the original
seqmﬁn].byZmddmshifﬁngi:ﬂthyMsdiﬂ'mt
from shifting f{n] right by 1.5 first and then time scaling it
by 2. Whenever a fraction is entered into the x-axis scale
dialog box, [i.e. A=2 and B=3 hence A/B=2/3] it should be in
reduced form [i.e. A/B=2/3 instead of 4/6 or 12/18]. Also please
note that expanding the horizontal scale will create zeros
between points. This is due to the limitation of the graphics
routines used in the program.
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Note that this operation replaces the contents of the
array by the logarithm of the signal. However, since negative
values cannot exist in Magnitude, when the log of a magnitude
plot is requested, values between 1 and O (ie. numbers with
negative logarithms) will be assigned to positive values. In
order to display the logarithm of the magnitude, choose
instead Semilog option from Display menu.

Make Signal menu item allows Instantaneous Freq./
Group Delay and Power to be assinged to the real or imaginary
parts or magnitude or phase of a new signal. However, since
Instantaneous Freq./Group Delay and Power are computed
values, the reverse is not possible.

A sampling frequency option is not included in this
educational version in order to present the actual results of
the FFT algorithm independent of the sampling rate. If a
sampling frequency f, (or sampling interval, T) is specified,
scale the x-axis units of the transformed signal by fyN or
1/TN where N is the Transform record length. For example, if
the sampling frequency fg =10Hz (or sampling interval T=0.1s)
and the transform length is N=32 points, muitiply x-axis units
by 10/32 to obtain correct scale in Hz.

These functions are computed as the difference of the
phase array. Depending on the Transform recard size N, a
scale factor of N is used for the instantaneous frequency and
N/27¢ for group delay.

Upon leaving the program, you will find a folder named
Scrap on the desktop. The bins are stored in this folder as
scrap files when you leave the program. The first scrap
document (scrap #0) must not be removed from the scrap
folder in order for the program to store scrap documents in
this file the next time.

You are also provided with a Transforms, Windows,
Modulation... Data Folder on the desktop which contains
images that the program needs for certain dialog boxes. If
that folder is not on the same disk as the program, the
program will bomb whenever a dialog box that requires those
images is brought up.

Some of the dialog boxes may alter the values of the
parameters (defauit values) even if they have been cancelled.

« Signal generation in Magnitude: If a signal is
generated in Magnitude mode, the program will take the
absolute value of the waveform. This is due to the fact that
magnitude, by definition, is non-negative.

 Graphics: Due to the available graphics resolution,
only three decades (10°) of a given signal can be
distinguished on the screen. However, the pointer monitor on
the upper right hand comer of the Graph window shows
values in scientific notation. The default machine zero is set
to 105, which can be changed by using Set display zero.






